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Über dieses Buch
Auf einen Blick

Ziel dieses Dokuments
Diese Anleitung beschreibt anhand eines Applikationsbeispiels die verschiedenen Schritte zur schnellen 
Installation, Konfiguration und Steuerung der  TeSys U -Motorstarter. Darüber hinaus können Sie mithilfe 
dieses Schnelleinstiegs auf einfache Weise ein CANopen-Kommunikationsnetzwerk einrichten. 
Voraussetzung hierfür sind jedoch Grundkenntnisse über speicherprogrammierbare Steuerungen (SPS) 
und applikationsspezifische Software (Unity Pro, Sycon usw.). Sie benötigen keine weiteren Unterlagen, 
um diese Aufgabe durchzuführen. 

Weitere Einzelheiten über andere Leistungen der TeSys U-Motorstarter finden Sie in den unten 
aufgeführten Dokumenten.

Weiterführende Dokumentation

Diese technischen Veröffentlichungen sowie andere technische Informationen stehen auf unserer 
Website www.schneider-electric.com zum Download bereit.

Benutzerkommentar
Ihre Anmerkungen und Hinweise sind uns jederzeit willkommen. Senden Sie sie einfach an unsere E-
mail-Adresse: techcomm@schneider-electric.com.

Titel der Dokumentation Referenz-Nummer

CANopen-Kommunikationsmodul LULC08 - Benutzerhandbuch 1744084

TeSys U-Kommunikationsvariablen - Benutzerhandbuch 1744082

TeSys U-Starter LUB/LUS - Kurzanleitung 1629984

Steuereinheiten LUCM/LUCMT/LUCBT/LUCDT - Kurzanleitung AAV40503

CANopen - Handbuch zur Hardware 35010857

TeSys DFB-Angebot - Benutzerhandbuch 1672600
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Einführung
1672604   01/2009
Einführung 
Inhalt dieses Kapitels
Dieses Kapitel enthält die folgenden Themen:

Beschreibung der Applikation

Einführung
Das Applikationsbeispiel hilft Ihnen bei der schrittweisen Definition der D.O.L.-Motorstarter (Direktstarter) 
zwecks: 

Bereitstellung des thermomagnetischen Schutzes,
Motorregelung und
Erzielung der Rückführung des Schützes und der Schutzschalterauslösung.

Beschreibung der Applikation
Motor 1 (M1):
Drehstrommotor Klasse 10, 5,5 kW (7,4 hp) bei 440 V, 50 Hz, Nennstrom In = 10,5 A, D.O.L. 
Motor 2 (M2):
Drehstrommotor Klasse 20, 7,5 kW (10,1 hp) bei 440 V, 50 Hz, Nennstrom In = 14,7 A, D.O.L. mit 
Fernüberwachung der Motorlast.

Konventionelle Lösung
Das untenstehende Schema zeigt die Verdrahtung bei Verwendung der konventionellen Lösung: alle 
Informationen zur Regelung und Rückführung werden über eine SPS geschaltet.

Thema Seite

Beschreibung der Applikation 5

Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 6

Schema für Leistung Schema für Steuerung

M1

5.5 kW

440 V 50 Hz

KM1

M2

Q1 Q2

7.5 kW

KM2
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Einführung
Motorstarter Tesys U - die Lösung aus dem Hause Schneider Electric 

Schaltpläne für Leistung und Steuerung in der von Schneider Electric angebotenen Lösung 

In der Lösung von Schneider Electric verwendete Steuereinheiten
Die hier beschriebene Lösung von Schneider Electric verwendet TeSys U, um den verschiedenen 
Kundenanforderungen gerecht zu werden.

LUCA12BL ist eine mit Motor 1 verwendete Standard-Steuereinheit zur Erfüllung der 
Grundbedürfnisse:

Dezentrale Motorsteuerung (Start/Stopp)
Bereitstellung von Statusinformationen (bereit, in Betrieb, Fehlerbedingung)

LUCD18BL ist eine erweiterte Steuereinheit, die mit Motor 2 über die Standardbedürfnisse hinaus für 
zusätzliche Anforderungen verwendet wird:

Warnmeldungen
automatisches und dezentrales Rücksetzen über den Bus
Angabe der Motorlast
differenzierte Fehlererkennung

Schema für Leistung Schema für Steuerung

1. TSXCPP110 CANopen-Master-Modul einschließlich 
PCMCIA-Karte und Anschlussadapter
2. TSXCANC••-Kabel einschließlich TSXCANKCDF90T-
Steckverbinder
3. TSXCANTDM4-Abzweigung mit 4 Sub-D-
Steckverbindern für Knotenanschlüsse und 
Schraubklemmen (24V- und Bus-Verbindung zum 
LULC08-Modul)
4. Vorverdrahtete Spulenverbindung LU9BN11L

A
1

A
2

LUCAppBL

5.5 kW

Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC08

CANopen
bus
24 Vdc

CANopen
bus
24 Vdc

LULC08

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

2

1

4 4

LUCDppLUCApp

LULC08 LULC08

TeSys UTeSys U

24 Vdc

3
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Einführung
Architektur des TeSys U-Systems
Die folgende Architektur zeigt die Hauptkomponenten eines auf Grundplatte montierten TeSys U-
Systems:

Legende Bestellnummer Beschreibung

1 Premium Speicherprogrammierbare Steuerung (SPS)

Modicon M340

2 TSXCPP110 CANopen-PC-Karte (nur für Premium)

3 TSXCANKCDF90T Winkel-Steckverbinder

4 TSXCANCA50 Kabel, maximal 50 m (164 ft)

5 TSXCANTDM4 Abzweigung mit 4 Sub-D-Steckverbindern (24V- und Bus-Verbindung)

6 TSXCANKCDF180T Kabel und ein Steckverbinder (Slave-seitig) (mit Leitungsabschluss = OFF)

7 LUB12 Grundgerät (Leistungsbasis) TeSys U 

8 LUCA12BL Standard-Steuereinheit

9, 12 LULC08 CANopen-Kommunikationsmodul

10 LUB32 Grundgerät (Leistungsbasis) TeSys U 

11 LUCD18BL Steuereinheit „Erweitert“ 

13 TSXCANKCDF180T Reihenschaltung (Daisy-Chain) einschließlich Kabel von ca. 1 m (3,3 ft) und 
ein Steckverbinder (mit Leitungsabschluss = ON)

14 LU9BN11L Vorverdrahtete Spulenverbindung (optional) oder

15 (Standardverbindung, 
geht mit LULC08 einher)

Steckbare Klemmenleiste für direkte Steuerung von A1/A2-Klemmen

1 2 3 54 6 7 8 9

13

10

11

12

15 14
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Einführung
Software-Tools
Die folgenden Software-Tools müssen zum Einstellen der Applikationen verwendet werden. Für die 
Verwendung dieser Tools sind Basiskenntnisse erforderlich.

Netzwerkbedingungen
Protokoll: CANopen

Baudrate: 500 kbps

Adressen:
1 für TeSys U Motor 1
2 für TeSys U Motor 2

Fehlerausweichmodus:

Im Falle eines Kommunikationsverlustes mit der SPS, bietet der Fehlerausweichmodus die Möglichkeit, 
den Motor auf verschiedene Arten zu betreiben. Stellen Sie den Parameter 682 auf einen der folgenden 
Werte ein:

Der an die Applikation angepasste Fehlerausweichmodus ist:
Wert 1 = Eingefroren für Motor 1
Wert 2 = Forcierter Halt für Motor 2

Bestellnummer Beschreibung

Unity Pro
Unity Pro XL V4.0 (und spätere Versionen) 

Programmierplattform.
Programmiersoftware für SPS vom Typ Premium und M340.

SYCSPULFUCD29M Sycon V2.9-Netzwerk-Konfigurationssoftware für SPS vom Typ 
Premium (Einzelbenutzer-Lizenz). 

 Ctrl_cmd_u Zyklische Regelung/Steuerung TeSys U. Laden Sie die TeSys U 
DFB-Bibliothek von der Webseite www.schneider-electric.com  
(siehe Seite 19) herunter.

Wert Fehlerausweichmodus Beschreibung

0 Deaktiviert Es wird kein Ausweichmodus angewandt. Dies ist nicht empfehlenswert.

1 Eingefroren Bei Erkennen eines Kommunikationsverlustes behält der Motor seinen 
Status:

Läuft der Motor, bleibt er in diesem Zustand.
Stoppt der Motor, bleibt er im Stoppzustand.

Es ist kein Wechsel des Steuerungsstatus zulässig. Eine neuer Befehl wird 
erst nach dem Rücksetzen eines Kommunikationsverlustes berücksichtigt 
(703.3).

2 Forcierter Halt 
(Standardwert)

Der Motor wird in den Stopp-Zustand forciert.
Ausgang OA1 = 0
Ausgang OA3 = 0

3 Unverändert Ein Wechsel des Steuerungsstatus ist zulässig. Eine neuer Befehl wird 
sogar vor dem Rücksetzen eines Kommunikationsverlustes berücksichtigt 
(703.3).

4 Forcierter Rechtslauf Ausgang OA1 = 1 (direkt) 
Ausgang OA3 = 0

5 Forcierter Linkslauf Ausgang OA1 = 0
Ausgang OA3 = 1 (2 Drehrichtungen)&#8207;
8 1672604 01/2009
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Einrichten der Motorabgänge TeSys U
1672604   01/2009
Einrichten der Motorabgänge TeSys U 
Inhalt dieses Kapitels
Dieses Kapitel enthält die folgenden Themen:

Einstellungen der Steuereinheiten LUCA12BL und LUCD18BL

Einstellen des Strombereichs an den Steuereinheiten
Die nachfolgende Abbildung zeigt, wie der Strombereich der Steuereinheit mit einem Schraubendreher 
(in diesem Fall LUCA12BL) eingestellt wird:

Stromeinstellungswerte
Die nachfolgende Tabelle zeigt die Einstellungen für LUCA12BL (Steuereinheit „Standard“) und für 
LUCD18BL (Steuereinheit „Erweitert“):

Thema Seite

Einstellungen der Steuereinheiten LUCA12BL und LUCD18BL 9

LULC08 Steckverbinder, Baudrate und Adresseinstellungen 10

4.00A

LUCA / LUCD

LULC08

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Steuereinheit Motor Stromeinstellbereich Motor-Nennleistung Stromeinstellwert = Motor-
Bemessungsstrom

LUCA12BL M1 3..12 A 5,5 kW (7,4 hp) 10,5 A

LUCD18BL M2 4.4..18 A 7,5 kW (10,1 hp) 14,7 A
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Einrichten der Motorabgänge TeSys U
LULC08 Steckverbinder, Baudrate und Adresseinstellungen 

Beschreibung
Verwenden Sie die DIP-Schalter unter dem Kommunikationsmodul LULC08, um die CANopen-Baudrate 
und die Adresse einzustellen.

1 CANopen Sub-D9-Steckverbinder
2 E/A-Klemmenleiste und 24 VDC
3 Baudrate
4 Adresse

Baudrate
Weisen Sie eine Baudrate (10, 20, 50, 125, 250, 500, 800 oder 1.000 kbit/s) unter Verwendung der 3 links 
befindlichen (höchstwertigen) Schalter (SW8 bis SW10) zu. 

In der Applikation beträgt die Baudrate 500 kbit/s:

Adresse
Weisen Sie eine Adresse von 1 bis 127 zu, und verwenden Sie hierfür die 7 rechts befindlichen (niedrigst-
wertigen) Schalter (SW1 bis SW7). Die Adresse 0 (null) ist nicht zulässig und wird als ungültige 
Konfiguration angesehen.

In der Applikation handelt es sich um die Adressen 1 und 2:

4321

LO1LI1LI2
24V c

1 2 3 4

6 7 8 9

(GND)
CAN_H

CAN_V+

5

CAN_L
CAN_GND

(CAN_SHLD)

SW10 SW9 SW8 Baudrate

1 0 1 500 kbit/s

SW10 SW9 SW8

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1 Adresse

0 0 0 0 0 0 1 1 (Standardwert)

0 0 0 0 0 1 0 2

Adresse 1 für TeSys U Motor 1 Adresse 2 für TeSys U Motor 2

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW7 SW6 SW5 SW4 SW3 SW2 SW1

on

off
10 1672604 01/2009
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Einrichten eines Kommunikationsnetzwerks in einer SPS
1672604   01/2009
Einrichten eines Kommunikationsnetzwerks in 
einer SPS
Einführung
Dieses Kapitel beschreibt die schrittweise Einrichtung eines Kommunikationsnetzes in einer SPS.

In der nachfolgenden Tabelle wird die Software angegeben, die für das Einrichten des Kommunikations-
netzes entsprechend der in der SPS verwendeten Applikation erforderlich ist.

Inhalt dieses Kapitels
Dieses Kapitel enthält die folgenden Themen:

SPS Zum Einrichten der Kommunikation verwendete Software

Premium Unity Pro und
Sycon

Modicon M340 Unity Pro

Thema Seite

3.1 TeSys U in einem CANopen-Netzwerk mit Unity Pro und Sycon (für eine Premium-SPS) konfigurieren 12

3.2  TeSys U in einem CANopen-Netzwerk mit Unity Pro konfigurieren (für eine SPS des Typs M340) 16

3.3. DFB-Konfiguration über die Applikation 19
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Einrichten eines Kommunikationsnetzwerks in einer SPS
3.1 TeSys U in einem CANopen-Netzwerk mit Unity Pro und Sycon (für eine Premium-SPS) konfigurieren

Konfigurationsverfahren für eine Premium-SPS

1)  Herunterladen der EDS-Dateien
Die folgende Tabelle beschreibt die zu befolgenden Schritte, gemäß denen die Tesys U zugeordneten EDS-
Dateien und Symboldateien von der Webseite www.schneider-electric.com heruntergeladen werden können:

Die nachstehende Tabelle zeigt die Zuordnung der beiden TeSys U-Varianten und der zugehörigen 
EDS-Dateinamen.

Die Zeichen Sc stehen für Starter-Controller (Motorabgang).
Die Zeichen St und Ad stehen für Standard- und Advanced (erweiterte) Steuereinheit.

Schritt Aktion

1 Öffnen Sie die Webseite von Schneider Electric: www.schneider-electric.com.

2 Klicken Sie auf Products and Services (Produkte und Service) und anschließend auf Automation and 
Control (Automatisierungs-  und Steuerungstechnik).

3 Klicken Sie im Abschnitt Downloads in der linken Menüleiste auf Current offers (Aktuelle Angebote).

4 Wählen Sie in der Dropdown-Liste Choose a function (Funktion wählen) die Funktion Motor 
Control (Motorabgangstechnik).
Wählen Sie in der Dropdown-Liste Choose a range (Produktreihe wählen) das Produkt TeSys U.
Wählen Sie in der Dropdown-Liste Choose a type of document (Dokumententyp wählen) den Typ 
Software/Firmware.

Klicken Sie auf Find (Suchen).

5 Wählen Sie Communication Module Tesys U CANopen (Tesys U CANopen-Kommunikationsmodul) 
und laden Sie die Datei LULC08_EDS_DIB_files_V100.exe herunter.

6 Auf Ihrer Festplatte doppelklicken Sie auf die Datei LULC08_EDS_DIB_files_V100.exe. Klicken Sie im 
eingeblendeten Fenster „Licence for software downloaded from Schneider-Electric web sites" (Lizenz 
für Software, die von Schneider Electric-Webseiten heruntergeladen wurde) auf Accept (Ich stimme 
zu). Öffnen Sie dann den Zielordner und klicken Sie auf Install (Installieren).

7 Wählen Sie die beiden EDS-Dateien entsprechend Ihren beiden TeSys U-Konfigurationen:
TE_TESYSU_SC_ST0102E.eds
TE_TESYSU_SC_AD0102E.eds

Variantenbezeichnung EDS-Dateinamen Motor (für die Applikation)

TeSys U Sc St TE_TESYSU_SC_ST0102E.eds Motor 1

TeSys U Sc Ad TE_TESYSU_SC_AD0102E.eds Motor 2
12 1672604 01/2009



Einrichten eines Kommunikationsnetzwerks in einer SPS
2)  Konfiguration des Applikationsnetzwerks
Die ersten Konfigurationsschritte mit der Software Unity Pro XL werden nachfolgend beschrieben:

 
Setzen Sie die Konfiguration mit der Sycon-Software fort, wie weiter unten beschrieben:

Schritt Aktion

1 Starten Sie die Software Unity Pro XL V4.0.

2 Konfigurieren Sie die SPS Premium und die Kommunikationskarte (PCMCIA usw.):

3 Speichern Sie Ihre Applikation als .STU-Datei.

4 Doppelklicken Sie auf die PCMCIA-Karte. Das Fenster PCMCIA-CANOpen-Karte wird geöffnet:

Möglicherweise ist eine Bearbeitung in diesem Fenster nicht erforderlich. 
Um den Konfigurationsprozess fortzusetzen, klicken Sie auf die Schaltfläche Sycon. Wird diese nicht 
dargestellt, installieren Sie die Software Sycon noch einmal.

Schritt Aktion

1 Klicken Sie in der Software Sycon V2.9 auf die Menüfolge File → New.

2 Wählen Sie im Dialogfenster Select fieldbus  die Option CANopen und bestätigen Sie dies.

3 Importieren Sie Ihre EDS-Datei durch Anklicken von File → Copy EDS.

4 Suchen Sie dann Ihre eigene Datei TE_TESYSU_xxx.eds.

5 Fügen Sie einen Master ein: 
- Klicken Sie auf die Menüfolge Insert → Master... oder
- wählen Sie 

6 Wählen Sie im Fenster Insert Master das Modul TSXCPP110 aus der Liste Available masters. 
Klicken Sie auf die Schaltfläche Add>> und bestätigen Sie mit OK.

7 Fügen Sie einen Knoten ein: 
- Klicken Sie auf die Menüfolge Insert → Node... oder
- wählen Sie 
1672604 01/2009 13



Einrichten eines Kommunikationsnetzwerks in einer SPS
8 Wählen Sie im Fenster Insert Node das Modul TeSysU_Sc_St und anschließend TeSysU_Sc_Ad aus 
der Liste Available nodes. 

TeSysU_Sc_St befindet sich an Adresse 1 und TeSysU_Sc_Ad an Adresse 2.

9 Wählen Sie zum Setzen der Busparameter das Menü Settings → Bus Parameter:

Wählen Sie eine Baudrate von 500kBit/s und bestätigen Sie mit OK.

10 Doppelklicken Sie auf einen Knoten, um das Fenster Node Configuration zu öffnen. Klicken Sie auf die 
Schaltfläche Object Configuration. Das entsprechende Fenster wird geöffnet:

Stellen Sie für Node1 (TeSysU_Sc_St) den Fehlerausweichmodus für Kommunikationsverlust ein: 
1 (eingefroren).
Behalten Sie für Node2 (TeSysU_Sc_Ad) den Fehlerausweichmodus für Kommunikationsverlust 
bei: 2 (Stopp).

Die CANopen-Adresse (mit Index:Unterindex) für den Fehlerausweichmodus bei 
Kommunikationsverlust ist 2007:21. Wählen Sie diese im oberen Bereich und bearbeiten Sie sie 
anschließend im unteren Bereich. 

11 Speichern Sie die Konfiguration durch Anklicken der Menüfolge File → Save as . Ihre 
Konfigurationsdatei hat jetzt die Erweiterung .CO.
Verlassen Sie die Software Sycon.

Schritt Aktion
14 1672604 01/2009



Einrichten eines Kommunikationsnetzwerks in einer SPS
 
Vervollständigen Sie den Konfigurationsprozess mit der Software Unity Pro XL im Fenster CANopen 
PCMCIA CARD: 

3)  Funktionstests des Kommunikationsnetzes inkl. Premium-SPS und -Produkte ausführen 

Schritt Aktion

1 Klicken Sie auf die Schaltfläche Select Database  und öffnen Sie die *.CO-Datei.

2 Wählen Sie die Menüfolge Edit → Validate (Bearbeiten -> Bestätigen), um die Konfiguration zu 
bestätigen. 
HINWEIS: Haben die Ein-/Ausgänge nicht die korrekten Werte, wird eine Fehlermeldung ausgegeben. 

• Nb of words (%MW) muss bei Eingängen mindestens 13 sein und bei Ausgängen 14. 
• Index of 1st %MW muss bei Eingängen 0 sein und bei Ausgängen mindestens 13. 
Ändern Sie einen Wert, bestätigen Sie diesen erneut.

3 Wählen Sie die Menüfolge Build → Rebuild all project (Generieren -> Alle Projekte neu generieren).

Schritt Aktion

1 Verbinden Sie das entsprechende Programmierkabel Ihres PCs mit der Premium-SPS.

2 Schalten Sie die Premium-SPS ein.

3 Klicken Sie auf Connect.

4 Klicken Sie auf das Menü PLC. Das Fenster Transfer Project To PLC wird geöffnet. Klicken Sie auf die 
Schaltfläche Transfer .

5 Schalten Sie die beiden TeSys U-Systeme ein: die grüne STATUS LED an der Frontseite von LULC08 
blinkt und leuchtet dann konstant.

6 Der Kommunikationsbetrieb sollte einwandfrei funktionieren.
HINWEIS: Funktioniert der Kommunikationsbetrieb nicht korrekt (entweder blinkt die grüne STATUS-
LED ununterbrochen oder die rote ERR-LED leuchtet), finden Sie im Benutzerhandbuch von TeSys U 
LULC08 - CANopen weitere Informationen.

7 Das Fenster CANopen PCMCIA CARD enthält die Registerkarte Debug. Die nachfolgenden Tabellen 
sind Auszüge dieser Registerkarte und verweisen auf Adressen, die den zyklischen Austausch pro Gerät 
beinhalten. Benennen Sie die Variablen in der Weise, dass eine Programmierung mit Namen vermieden 
wird, die keine Informationen zu den Inhalten der Speicherzelle  (z. B. Reg_455_motor_1 anstelle von 
%IW\3.1\0.0.0.0) liefern.

Die nächste Registerkarte im Fenster CANopen PCMCIA CARD ist die Registerkarte Fault. Sie ist 
normalerweise deaktiviert, außer im Falle eines Kommunikationsproblems. Im grauen Quadrat vor dem 
Namen wird ein rotes Zeichen angezeigt, und es wird eine Diagnoseseite geöffnet.

Inputs

%IW\3.1\0.0.0.0

%QW\3.1\0.0.0.0

Reg_455_motor_1

Reg_704_motor_1

1

0

%IW\3.1\0.0.0.1

%QW\3.1\0.0.0.1 Reg_703_motor_1

0

0

%IW\3.1\0.0.0.2

%QW\3.1\0.0.0.2

0

0

%IW\3.1\0.0.0.3

%QW\3.1\0.0.0.3

0

0

Parameters Symbol Value

Parameters Symbol Value
Outputs
1672604 01/2009 15



Einrichten eines Kommunikationsnetzwerks in einer SPS
3.2  TeSys U in einem CANopen-Netzwerk mit Unity Pro konfigurieren (für eine SPS des Typs M340)

Konfigurationsverfahren für eine SPS vom Typ Modicon M340

1)  Konfiguration des Applikationsnetzwerkes
Die Konfigurationsschritte mit der Software Unity Pro XL lauten wie folgt:

Schritt Aktion

1 Starten Sie die Software Unity Pro XL V4.0.

2 Konfigurieren Sie die SPS Modicon M340 für CANopen:
Erstellen Sie über das Menü File ein neues Projekt.
Wählen Sie im Fenster New Project das Modul Modicon M340 aus der Liste BMX P34 2010 (CPU 
340-20 Modbus CANopen).

Bestätigen Sie durch Anklicken von OK.

3 Wählen Sie im Menü Structural view (Strukturansicht) im Project Browser (Projekt-Browser) die 
Menüoptionen Configuration → 0 : PLC bus → 0 : BMX XBP 0800 → 0 : BMX P34 2010 oder 
doppelklicken Sie auf das Modul P34 2010 in der Konfiguration. Der Bildschirm Communicator head 
CANopen (CANopen Kommunikator-Kopf) wird in einer neuen Registerkarte geöffnet:

4 Wählen Sie Configuration → 3 : CANopen. 
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5 Doppelklicken Sie in der Registerkarte CANopen  auf das Gerät:

Das Popup-Fenster New Device  wird geöffnet.

6 Legen Sie im Fenster New Device  die Konfiguration des ersten TeSys U-Geräts fest:
Wählen Sie CANopen drop → Motor control  → TeSysU_Sc_St
Setzen Sie die Topological Address auf 1
Bestätigen Sie durch Anklicken von OK.

7 Legen Sie im Fenster New Device  die Konfiguration des ersten TeSys U-Geräts fest:
Wählen Sie CANopen drop → Motor control  → TeSysU_Sc_Ad
Setzen Sie die Topological Address auf 2
Bestätigen Sie durch Anklicken von OK.

8 Die beiden TeSys U-Module und die Verbindungen werden auf der Registerkarte CANopen dargestellt. 

Klicken Sie der Reihe nach auf jedes Gerätebild. Es wird eine Konfigurationstabelle eingeblendet, in der 
Sie den Fehlerausweichmodus bei Kommunikationsverlust konfigurieren können:

Stellen Sie für TeSysU_Sc_St den Fehlerausweichmodus bei Kommunikationsverlust ein: 1 (eingefroren).
Stellen Sie für TeSysU_Sc_Ad den Fehlerausweichmodus bei Kommunikationsverlust ein: 2 (Stopp).

Schritt Aktion
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2)  Funktionstests des Kommunikationsnetzwerks inkl. M340-SPS und -Produkte ausführen 

9 Wählen Sie die Menüfolge Edit → Validate (Bearbeiten -> Bestätigen), um die Konfiguration zu 
bestätigen. 
HINWEIS: Möglicherweise wird im Bereich Rebuild All Project eine Meldung bezüglich der Anzahl der 
reservierten Bits und Wörter für IN/OUT angezeigt.  Kehren Sie in diesem Fall zum Bildschirm 
Configuration zurück und geben Sie die Werte ein, wie in der Meldung angegeben.

Konfigurieren Sie die Optionen gemäß dem Applikationsbeispiel: 

Stellen Sie die Übertragungsgeschwindigkeit auf 500 kBaud ein.
Nb of words (%MW) muss bei Eingängen 28 und bei Ausgängen 20 sein.
Index of 1st%MW muss bei Eingängen 0 und bei Ausgängen 100 sein.
Nb of bits (%M) muss bei Eingängen und Ausgängen 0 sein.

10 Wählen Sie die Menüfolge Build → Rebuild all project (Generieren -> Alle Projekte neu generieren), 
um das Projekt erneut zu generieren. Sobald die Werte korrekt sind, wechselt der Zustand von NOT 
BUILT (nicht generiert) auf BUILT (generiert).

11 Speichern Sie die Applikation unter einem speziellen Namen.

Schritt Aktion

Schritt Aktion

1 Schließen Sie über den USB-Port auf Ihrem PC ein Kabel (z. B. TSXPCX3030) an die SPS M340.

2 Schalten Sie die SPS M340 ein.

3 Klicken Sie auf Connect (Verbinden).

4 Klicken Sie auf das Menü PLC (SPS): das Fenster Transfer Project to PLC (Projekt in SPS übertragen) 
wird geöffnet. Klicken Sie auf die Schaltfläche Transfer (Übertragen).

5 Schalten Sie die beiden TeSys U-Systeme ein: die grüne STATUS-LED an der Frontseite von LULC08 
blinkt und leuchtet dann konstant. Die Kommunikation funktioniert einwandfrei.
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3.3. DFB-Konfiguration über die Applikation

Beschreibung
Das DFB-Angebot (Derived Function Blocks) für TeSys wurde mit dem Ziel entwickelt, die Integration von 
TeSys U-Motorabgängen in SPS-Applikationen zu vereinfachen und zu optimieren.

Der DFB Ctrl_cmd_u ist zur Regelung und Steuerung eines einzelnen TeSys U-Motorabgangs (max. 32 
A/15 kW) durch den zyklischen Datenaustausch in einem CANopen-Netzwerk bestimmt.

1. Herunterladen der DFB-Dateien
2. Installation der DFBs in Unity Pro
3. Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Weitere Informationen finden Sie unter TeSys DFB-Angebot - Benutzerhandbuch.

1) Herunterladen der DFB-Dateien
Die folgende Tabelle beschreibt die zu befolgenden Schritte für den Download des TeSys DFB-Angebots 
von der Webseite www.schneider-electric.com:

2) Installation der DFBs in Unity Pro

Schritt Aktion

1 Öffnen Sie die Webseite von Schneider Electric: www.schneider-electric.com

2 Klicken Sie auf Products and Services (Produkte und Service) und anschließend auf Automation and 
Control (Automatisierungs-  und Steuerungstechnik).

3 Klicken Sie im Abschnitt Downloads in der linken Menüleiste auf Current offers (Aktuelle Angebote).

4 Wählen Sie in der Dropdown-Liste Choose a function (Funktion wählen) die Funktion Motor 
Control (Motorabgangstechnik).
Wählen Sie in der Dropdown-Liste Choose a range (Produktreihe wählen) die Produktreihe TeSys 
U.
Wählen Sie in der Dropdown-Liste Choose a type of document (Dokumententyp wählen) den Typ 
Software/Firmware.

Klicken Sie auf >Find (Suchen).

5 Wählen Sie TeSys DFB offer package (TeSys DFB-Angebotspaket) und laden Sie die zip-Datei auf Ihre 
Festplatte herunter.

6 Entpacken Sie den Inhalt der TeSys DFB offer package.zip-Datei in ein einzelnes Verzeichnis Ihrer 
Festplatte. Daraufhin werden zwei Verzeichnisse - PL7 Pro und Unity Pro - angelegt, die jeweils die 
folgenden Ordner enthalten:

Schritt Aktion

1
Wählen Sie All Programs (Alle Programme) im Menü  Start und rufen Sie das Untermenü  
Schneider Electric → Unity Pro → Types Library Update (Aktualisierung der Typen-Bibliothek) auf.

2 Navigieren Sie im Fenster Types Library Update zum Menüelement 04 Cyclic control command  → 
FAMILY.DSC (04 Zyklischer Steuerbefehl -> FAMILY.DSC) und öffnen Sie dieses. 
HINWEIS: Die von Ihnen gewählte Applikationsversion muss mit Unity Pro kompatibel sein.

3 Klicken Sie auf die Schaltfläche Install family. Daraufhin wird ein Popup-Fenster mit der folgenden 
Meldung eingeblendet: “The installation has succeeded” (Die Installation war erfolgreich). Verlassen Sie 
anschließend das Programm.
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3) Abruf Ihres Projekts und der DFB-Applikation in Unity Pro

Kenndaten der Eingänge
Die folgende Tabelle beschreibt die DFB-Eingänge und ihre Verfügbarkeit in Abhängigkeit der 
Steuereinheit:

Schritt Aktion

1 Starten Sie die Software Unity Pro.

2 Rufen Sie über das Menü Tools das Untermenü Type Library Manager auf. Klicken Sie auf die 
Schaltfläche Access Assistant . Wählen Sie Ctrl_cmd_u und verschieben Sie dieses Element in den 
rechten Bereich mit dem Titel Objects to get:

Klicken Sie auf Copy into project.

3 Die DFB-Grafik wird dargestellt:

Ctrl_cmd_u

Reg_704

Run_fwd
Run_rev

Rst_flt
Rst_warn

Ther_ov_test
Trip_tst

Closed
Ready

Tripped

1

Reg_455
Reg_703

Alarm
Fault

Rst_auth

Running
Starting

Avg_curr

Eingang Typ Bereich Standardwert Beschreibung LUCA LUCD

Reg_455 INT 0...65535 0 Verknüpfung zum Register 455 der zyklischen 
Dateneingänge

√ √

Run_fwd EBOOL 0...1 0 Befehl zum Rechtslauf des Motors √ √

Run_rev EBOOL 0...1 0 Befehl zum Linkslauf des Motors √ √

Rst_flt EBOOL 0...1 0 Fehler Rücksetzen (im Falle eines internen 
Fehlers des Kommunikationsmoduls wird das 
Kommunikationsmodul durch einen Reset-Fehler 
auf die Werkseinstellung zurückgesetzt)

√ √

Rst_warn EBOOL 0...1 0 Warnung Rücksetzen (z. B. 
Kommunikationsverlust)

√ √

Ther_ov_
test

EBOOL 0...1 0 Automatischer Test bei thermischem 
Überlastfehler

  

Trip_tst EBOOL 0...1 0 Auslösungstest bei Überstrom über den 
Kommunikationsbus
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Kenndaten des Ausgangs
Die folgende Tabelle beschreibt die DFB-Ausgänge und ihre Verfügbarkeit in Abhängigkeit der 
Steuereinheit:

Programmierung DFB 1 für Motor 1

Ausgang Typ Bereich Standardwert Beschreibung LUCA LUCD

Reg_704 INT 0...65535 0 Verknüpfung zum Register 704 der zyklischen 
Datenausgänge

√ √

Reg_703 INT 0...65535 0 Verknüpfung zum Register 703 der zyklischen 
Datenausgänge

√ √

Ready EBOOL 0...1 0 System bereit: der Drehschalter steht auf der 
Position ON (Ein) und es liegt kein Fehler vor.

√ √

Closed EBOOL 0...1 0 Polstatus: geschlossen √ √

Tripped EBOOL 0...1 0 System ausgeschaltet: der Drehschalter steht auf 
der Position „Trip“ (Auslösung).

√ √

Fault EBOOL 0...1 0 Alle Fehler √ √

Alarm EBOOL 0...1 0 Alle Warnungen √ √

Rst_auth EBOOL 0...1 0 Fehler Rücksetzen erlaubt  √

Starting EBOOL 0...1 0 Hochlauf in Ausführung:
1 = Aufwärtsstrom ist höher als 10 % FLA
0 = Abwärtsstrom ist niedriger als 150 % FLA

 √

Running EBOOL 0...1 0 Motor läuft mit Stromerfassung, wenn höher als 
10 % FLA

 √

Avg_curr INT 0...200 0 Mittelwert Motorstrom (% FLA)  √

Schritt Aktion

1 Bezeichnen Sie die SPS-Register (%IW..., %QW...) entsprechend den TeSys U-Registern (455, 703 
und 704)
Für Knoten 1 (TeSys U_Sc_St):

Reg_455_M1: %IW\3.1\0.0.0.0
Reg_704_M1: %QW\3.1\0.0.0.0
Reg_703_M1: %QW\3.1\0.0.0.1

2 Verknüpfen Sie den Eingang Run_fw DFB1 mit der Startbedingung von Motor 1.

3 Verknüpfen Sie die DFB 1-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:
Ausgang DFB 1 „Closed“  = Position von Schütz KM1
Ausgang DFB 1 „Tripped“ = Position „Trip“ von TeSys U Q1 

4 Prüfen Sie, ob DFB 1 für Motor 1 Folgendes anzeigt:

1 Nicht zutreffend
2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden

Ctrl_cmd_u

Reg_704

Run_fwd
Closed

Tripped

1

Reg 455
Reg_703

Q1 tripped position
KM1 position

Reg_703_M1
Reg_704_M1Reg_455_M1

KM1 close command

Rst_flt2

Rst_warn2

Ther_ov_test1

Trip_tst1

Alarm2

Fault2

Rst_auth1

Running 1

Starting1

Run_rev2

Ready2

Avg_curr1
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Programmierung DFB 2 für Motor 2

Schritt Aktion

1 Bezeichnen Sie die SPS-Register (%IW..., %QW...) entsprechend den TeSys U-Registern (455, 703 und 704)
Für Knoten 2 (TeSys U_Sc_Ad):

Reg_455_M2: %IW\3.2\0.0.0.0
Reg_704_M2: %QW\3.2\0.0.0.0
Reg_703_M2: %QW\3.2\0.0.0.1

2 Verknüpfen Sie den Eingang DFB 2 Run_fw mit der Startbedingung von Motor 2.

3 Verknüpfen Sie die DFB 2-Ausgänge mit den SPS-Variablen für die Verwendung im Programm:
Ausgang DFB 2 „Closed“  = Position von Schütz KM2
Ausgang DFB 2 „Tripped“ = Position „Trip“ von TeSys U Q2 

4 Verknüpfen Sie den Ausgang DFB 2 Avg_curr mit einem SPS-Register für die Verwendung des 
Strommittelwertes von Motor 2 im Programm.

5 Prüfen Sie, ob DFB 2 für Motor 2 Folgendes anzeigt:

1 Nicht zutreffend
2 Zutreffend, jedoch nicht verwendet; kann von der SPS-Applikation verwaltet werden.

Ctrl_cmd_u

Reg_704

Run_fwd
Closed

Tripped

2

Reg 455
Reg_703

Avg_curr Average M2 current

Q2 tripped position
KM2 position

Reg_703_M2
Reg_704_M2Reg_455_M2

KM2 close command
Run_rev2

Rst_flt2

Rst_warn2

Ther_ov_test1

Trip_tst1

Ready2

Alarm2

Fault2

Rst_auth2

Running2

Starting2
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